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| Read This First

B Disclaimer

» While every effort has been made to ensure that the information contained in this
guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

» Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software, memory
cards (SD, SDHC and miniSD Cards), personal computers, or peripheral devices,
or due to use of a memory card not initialized by a Canon camcorder.

B Trademark Acknowledgments

» QuickTime is a trademark of Apple Computer, Inc.

« Microsoft® and Windows® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

- S, MiNi and are trademarks of SD Card Association.

» Other names and products not mentioned above may be registered trademarks
or trademarks of their respective companies.

© Canon Inc. 2007 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support data
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could

damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories

Use the following accessories to download recorded still images from a memory card
to your computer.

* IFC-300PCU USB Cable * DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The steps
and windows may vary depending on your computer and the version of software.
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| System Requirements

Please install the software on a computer meeting the following minimum
requirements.

0OsS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.

CPU: Pentium 500 MHz or better

RAM: Windows 98/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/Windows

2000/Windows XP systems with built-in USB ports

Free Hard Disk Space: <+ Canon Utilities
- ZoomBrowser EX: 200 MB or more
» Canon DV TWAIN Driver: 25 MB or more
» Canon DV WIA Driver: 25 MB or more

Display: 1024 x 768 pixels or better/High Color (16 bit) or better

@ O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
\&¥ o Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
O A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft® Windows® 98 Second Edition: Windows 98
Microsoft® Windows® Millennium Edition: Windows Me
Microsoft® Windows® 2000 (Service Pack 4): Windows 2000
Microsoft® Windows® XP Home Edition or Professional

(Service Pack 1 or 2): Windows XP

System Requirements I 5



| What is Digital Video Software?

The following software will be installed by installing the Digital Video Software.

B ZoomBrowser EX

* Viewing downloaded still images

 Categorizing, organizing, and searching large volumes of still images
« Editing still images

» Changing the data for still images and save them as new files

* Viewing still images in a slide show

» Adding sound to a still image

B CameraWindow

* Downloading still images from a memory card to your computer

* Viewing still images recorded on a memory card

* Printing still images recorded on a memory card without downloading the still
images to the computer

B USB Driver

* Driver software that enables you to download still images from a memory card to
a computer. Users of Windows XP do not need to install this driver software. An
OS standard driver will be installed automatically.

» Windows 98/Windows 2000: Canon DV TWAIN Driver

* Windows Me: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do with the

main features and how to operate them. For more detailed operational instructions,
refer to the Help menu of each software program.
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| Windows

CameraWindow

CameraWindow is a program created to download still images from the memory card
to the computer. Furthermore, you can print still images recorded on the memory card
without having the images downloaded to the computer ([ 1] 39), and you can confirm
and change the owner name of the camcorder you specify ([ ] 86). Refer to Starting
CameraWindow ([]] 28) for launching the software. The Remote capture function is

not supported by the camcorder.

B [Acquire Images] Tab

This tab is used for downloading still images recorded on the memory card by
connecting a camcorder or a card reader/writer to the computer.

Camera Control window

& CameraWindow - Canon, ¥k 4k

Selects a function in the Camera ——
Control window.

Images will be downloaded to
the computer, and ZoomBrowser EX
starts.

Images in the camcorder are
displayed allowing you to select
images.

Placing a check mark here makes —
the Camera Control window to open
automatically the next time you

{ Acguire Images | Print | Set to Camera | Femate shooting)

Downloads uzing camera

2 QN
VR et
LS

Press the camera's button

| Downloads using computer
| I.__
2 Starts to download images

‘ £

— /| Diisplays this screen when the camera is connected

Freferences...

Lets you select and download images

connect the camcorder.

Specify the image type to be downloaded and
the destination folder.
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MW [Print] Tab
This tab is used for printing still images on the memory card without having the images

downloaded to the computer. The window varies depending on the selected printing
type. Refer to Printing Still Imnages Recorded on the Memory Card ([] 39).

Camera Control window

Prlnt.S all still Images In the card -.-’-‘n.cquirelmages|- Print | Setto Camera | Femate shooting |
one Image per page. ‘ ‘

_ o _ ;_;." Print All Photos
Prints all still images in the card — =
as an index page (rows of images
with file names and image | gl

. . = Frint Contact Sheet with All Photos
information). =F

Prints according to the DPOF print _ Print according to DPOF settings

settings set by the camcorder to the
still images recorded on the card.

W]
L

Select an image and print

il
£yl

Displays a list of the still images ——
in the card, allowing you to select
which ones to print.

Digplays thiz screen when the camera iz connected

=[EhCes Firizh
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B [Set to Camera] Tab

This tab is used for confirming and changing the owner name of the camcorder you
can specify ([1] 86) and uploading the still images to the card. My Camera function is

not supported by the camcorder.
¢ CameraWindow - Canon 5k * % & | . : E

| &cquire Images | Print | Set to Camera | Remate shootinjé

Camera Control window

Set My Camera

| L

Confirmsfchanges camera settings

Enter or change the name of
the camcorder’s owner.

=
&

Uploading the images from the —lrjﬁilu Uploads images to the camera
computer
Dizplays thiz screen when the camera is connected
2Py Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera]

<4 window. If you click [Creating My Camera data] in the [My Camera] window,
[My Camera Maker] will be launched. [My Camera Maker] is a program that
enables you to create and import My Camera contents (Start-up images, Start-
up sound, Shutter sound, Operation sound and Self timer sound) to
camcorders that support this function. Your camcorder does not support the My
Camera function.
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B Camera Browser Window

IMG_0101JPG

;‘-’Image Download [‘ gPrlnt -

File(F) EdtiE) Wiew(v) H

& CameraWindow - Ca
piH)

IMG_0102.PG IMG_0102.PG

ﬁ Start ZoomBrowser EX

Se

IMG_0104.PG

Prints the selected still images.

Starts ZoomBrowser EX.

ﬂ File Informat

Selects the still image selection method.

Changes the size of the thumbnail.

EX

tion:

File Mame:  IMG_0101.JPG

Modified:  200:/01/1514: 4532

File Size: a0 KB

Image Size: G40

ﬂ Histograrn:

480

L —

ﬂ Dretailz:

Tkem Mame Yalue A
File Marme IMG_010
Camera Model M., Canon
Shoating DatefTi... 1/15/200
Shooting Mode Portrait
Fhoko Effect Off

T (Shutter Speed) 1740

Ao CAperkure Yal
Light Metering

Exposure Comp...

150 Speed
Lens

Focal Length
Digital Zoorm
Image Size
Image Quality
L™

l... 2.0
Evalua
1)

Auto
2.6 -8

7.9 mm

None

640480

Fine

kit

=)

w

/)

Selects imag

1af 4

Selects whether to show or hide the image

frame and file name.

Still image information and a histogram
(This will not be displayed when using a card reader/writer.)

70\ If your camcorder supports wide size still image (16:9 such as 1920 x 1080

still images (4:3).

ﬂ CameraWindow - Canon % % Sk

I Windows

FilefF) Edit(E) Wiew(W) Help(H)

@ Image Download [*&g Print =

IMG_0101.JPG IMG_0102.JPG

IMG_0103.IPG

(T
!{T Start ZoomEBrowser EX
Select - _J_ :‘!I @

pixels) recording, the thumbnails that appear in this window will be also 16:9
images. The sample images used on this instruction manual are normal size



Main Window

ZoomBrowser EX is a software program used for organizing, printing and editing the

downloaded still images. If you wish to start ZoomBrowser EX without connecting the
camcorder or card reader/writer, double-click the Z@;ﬁ on the desktop, or click the E
Windows [start] menu and select [All Programs] » [E}‘ianon Utilities] » [ZoomBrowser

EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click or select [Exit] from

the [File] menu.

#7 ZoomBrowser EX - C:\Documents and Settings\Canoniiy Documents\My Pictures | E
File Edit View Tools Intermet Help

& = = —
‘ Tasks (2] r 1)/ Side Show Q Search ]
| )

IL@' fioquire & Camers Setiings f2°°m Mod | SerallMade | Preview Made

= ar EXHDE J— [t )
1 — =" Wiew & Classity

¥ 200X_01_15
@ Edit ) _01_

( Favorite Folders | )l Falders )

Last Acquired Images

2 e | | =) [Z]) Al Images

= 4 Shooting Date
JE] z00x_01_15

e ]

Favorite: Folders

=1 My Pictres
¥ 200x_01_15
) 200%_01_20

3 search Results

| Selected Ttems: 0

1 Task Area

[Acquire & Camera Settings]: Use this to display the Camera Control window to
download still images, to print stillimages without
having them downloaded to the computer and to
configure the camcorder settings.

[View & Classify]: Use this to view and organize still images.
[Edit]: Use this to edit still images.
[Export]: Use this to change the data for still images and

save them as new files, extract still images from
movies, back up to CD-R/RW (Windows XP only),
or export shooting properties to a text file.

[Print]: Use this to print downloaded still images.
[Internet]: Use this to attach selected still images to E-mail
messages.
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Folders Area

You can select a folder to be displayed in the Browser Area. In the [Last Acquired
Images] panel, the newly downloaded still images are placed into virtual folders
classified by recording dates. In the panel below, the folders where the downloaded
still images are actually saved in are displayed. Selecting the [Favorite Folders] tab
shows only the folders that are registered as favorites. The [All Folders] tab shows all
available folders. E| indicates that newly downloaded still images are in the folder.
To register folders as Favorites, follow the instructions below.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

To remove the registered folder, select the folder, and click [Remove].

Browser Area

This area displays the images contained in the selected folder. If you place the
cursor over a thumbnail in the browser area, will be displayed at the upper right
corner. Clicking skips over folders to zoom in directly on the intended folder.

o Clicking on 2 images while holding down the [Shift] key selects also all

& images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple
images.
4 Browser Area Tool Bar

The menu items vary depending on the View Mode.
1 2 3 4 5 6 7 8

L N - |
FP i T N NG L i -y L,—a—-‘ l*ﬁFilterTnnl |

1 | Previous/Next Displays the previous/next image in the current folder.

2 (Up Displays the folder in the upper tiers of the hierarchy.

3 | Select Allows you to select all images and deselects images.

4 | Information Allows you to select the information to be shown. You can
also hide the pop-up window by clearing the checkmark.
The pop-up window appears when you move the mouse
over a thumbnail.

5 | Pan Changes the area displayed when you zoom in on a folder

or image in the Browser Area and drags the thumbnail list.

Restore Display Size | Changes the size of the thumbnail list to fit the window.

Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.

Filter Tool Allows you to select which still images to display
according to the star rating. When you download the
images, the star rating is set to two stars as a default. To
change the star rating, refer to Applying Star Ratings and
Keywords ([]] 48).

Windows




5 View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

Zaom Made | Serell Mode | Preview Mode|

My Pictures ¢ > 2 [B-0-[nq ([ 7 Fiter Tl

3] 200%_01_15

IMG_0103.PG  [MG_0104.0PG

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name.
Clicking a folder displays enlarged images. Selecting [Preferences] from the
[Tools] menu opens the [Preferences] window, on which you can select the
hierarchy of folders. In the screenshot below, [Maximum scroll mode folder
depth] (hierarchy of folders) is set to two.

Zoom pode | Seroll Mode | Preview Mode

My Picures €2 (R0 [Jmm
1 o (HESE B ol
(¥) _J 2oo% 01 20 Ao 2 Y Jnjmj

[Preview Mode]: Double clicking the folders at the bottom of the window, opens
the folder and shows a large still image in the folder along with detailed information.
You can change file name and comments. To display another image, click
[Previous]/[Next] or select an image shown at the bottom of the window.

Zoom Madz | Geroll Mode | PreviewMode |

2000115 € 4+ |H-0-
[&] Fie Informatiar: -

File Nare: [ IME_0101

Modiied 1/15/200% [ Protect

File Size: 820K8

Image Size: 640 % 480

DataType: PG

Sound

2] Star Rating

WIS

] Comment t
7 [¥] Keywords:

[Z] Brightness Histogram:
L —

[Z] Shoating Information:

Item Name Value

File Name IMG_0101.JPG

Camera Model Name  Canon sokkokek

Shooting Date/Time  1/15/200% 3:25:50 Ak i

IMG_0102.0PG  IMG_D103.JPG  IMG_D104.0PG
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6 Application Tool Bar

1 2 3 4 5 6

| I . |
E| Wiew Image Fropetties D?; slide Show "@ Seatch % Delete ['gj Rokate

1 | View Image Displays a selected image in the [Image Viewer] window.

2 | Properties Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in
[Preview Mode].

o Properties
Modified: 1415/200%
File Size: 828KB
{ Image Size: B40 % 480
;i‘ Data Tope: JFG
Sound:
View Image...

Path. CitDacuments and Settings\Cananihly Docu

] File Name:

IMG_0101

[A] StarRating:
[ Protect

[%] Comment

[ Kepwords
View/Madily Kepnards ...

[ Brightress Histogram:

E

(] Shooling Information:

A

Item Mame: Walue
File: Mame IMG_0101.JPG
E

Caron o ook
Shoating Date/Time  1/15/2002 4328 PM

3 | Slide Show Displays still images in a slide show.

4 | Search Allows you to search for images ([ 1] 53).

5 | Delete Deletes selected images.

6 | Rotate Rotates selected still images. A movie cannot be rotated.
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[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View Image]
or double-click an image.

1

10—
11 —
12—
13 =
14
15 =

2 34 5

6 7 8 9
||

”_HE D] D]] EB] @Svnch uuuuuu

entsk200%

Zoom Ratio: 100%

Previous/Next

Displays the previous/next image in the current folder.

Zoom In/Zoom Out

Enlarges/decreases a still image.

Pan

When the image is larger than the window, you can move
the image in the desired direction.

Print

Prints the selected still image. Refer to [One Photo per
Page Print] ([ 1] 44).

Edit

Allows you to perform the following operations: red-eye
correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting texts or
registering external image editing applications.

Auto Focus Frame

This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.
Information
Show Allows you to display multiple images at the same time.

Synchronize

Synchronizes the View functions across all displayed
images.

10 | Fit to Window Matches the image size to the size of the Image Viewer
Window.

11 | Restore Restores the standard display size.

12 | Zoom Slider Allows you to enlarge/decrease the displayed image.

Windows I 15




13 | Show Image Full Displays an image in full screen size.
Screen

14 | Change the Star Allows you to change the star rating.
Rating

15 | Capturing Frames | Extracts still images from movies. (Windows XP only)

B [Red Eye Correction] Window
Selecting [Red Eye Correction] from the [Edit] menu or the [Eet - icon allows you
to correct the red eye effect on a still image in the [Red Eye Correction] window.

= Red Eye Correction - C:iDocuments and SettingsiCanoniMy Documentsk200%_ 01 _154MG. ... |;‘@@

1
2
[] 5how Original Image
=] ® Q ARG
- Cow )
Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 | Manual Mode Point the cursor on a red eye so that the area is
highlighted green, and left-click the mouse.

16 I Windows



B [Auto Adjustment] Window
Selecting [Auto Adjustment] from the [Edit] menu, or clicking the & - icon and
selecting [Auto Adjustment] allows you to automatically correct the color balance of

the still image.

Auto Adjustment - C:\Documents and SettingsiCanoniy Documentsi200%_01_155MMG_01... |EHX|

Auto Adjust Image

Show Original Image

QAN ot

B [Color/Brightness Adjustment] Window

Selecting [Color/Brightness Adjustment] from the [Edit] menu, or clicking the
&e - jcon and selecting [Color/Brightness Adjustment] allows you to adjust the
brightness, saturation, contrast, intensity levels, tone curve and RGB of the still

image.

[l Color/Brightness Adjustment - C:\Documents and SettingsiCanoniMy Documentsi200X_01... _.@E|

Please select adjustment option:

| Color ddjustment ~]
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B [Sharpness] Window
Selecting [Sharpness] from the [Edit] menu, or clicking the &=« - icon and
selecting [Sharpness] allows you to emphasize and clarify the outlines of people
and objects.

Sharpness - C:\Documents and SettinpsiCanoniiy Documentsi200X_01_155MG_0104. PG }:,@lgl
“Shamen | Unshap Mask|
Amount; J ‘D =
a
® q M| = "'J'r_.—

B [Trim Image] Window
Selecting [Trim] from the [Edit] menu or the =t - jcon allows you to crop a still
image. Either drag the mouse on the image or specify the cropping area, and click
[Trim Image].

[ Tirim Image - C:MDocuments and SettingsiCanonWMy Documentsi200%_01_15MMG. 0103, JPG ‘Zl@@

Trim saitings.

Location [top-eft comer]:

¥ |0
i 0
Size of timming arsa
——
Wi
=
H 0

Cancel
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B [Insert Text] Window
Selecting [Insert Text] from the [Edit] menu, or clicking the &=t - jcon, and select
[Insert Text] allows you to write text on still images.

Insert Text - C:\Documents and Settings\CanonkMy Documentsi200X_01_155MG.0104..JPG \:.@lgl

Insert Text

Font Name:

Font Size:

Text Colar.

Test Attribute: B 7 0
[#] Aintislizs

Text

<Select the location on the image first, then
type your test in heres

o8 _These image correctio_n too_ls can be selected by clicking [Edit] » [Edit Image]
. in Task Area of the Main Window.
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| Installing the Digital Video Software

(D

O Be sure to install the Digital Video Software before connecting the
camcorder to the computer.

0o Users of Windows 2000 or Windows XP must first log in as an Administrator
to install programs.

Windows XP Users:

Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (the software such

as the [Scanner and Camera Wizard] starts automatically).

However, please note that there are several limitations to downloading still

images with this method. To avoid these problems, install ZoomBrowser EX to

download still images.

o It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

Set the DIGITAL VIDEO SOLUTION DISK in the computer’s
CD-ROM drive.
If the installer panel does not open automatically, use the following procedures
to display it.
- Windows 98/Windows Me/Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
Depending on the setting of your computer, the file extension “.EXE” may not
appear.

Select your country or region.

Select your language.

Installing the Digital Video Software



Click Digital Video Software [Easy Installation].

To select the installing software, click [Custom Installation].

Installer Panel —— Cangn DIG"ALVIDEO E
Solution Disk

Digital Wideo Software

Easy Installation
N/

Autornatically inskals al softwars.

Custom Installation )
— J

Select the software that you want to install,
QuickTime &.5

(_ Install \/.

Exit

If other software is running, close all programs and click
[OK].

Start installing Digital Yideo Solution Disk,
Close any other open appliu:atiu:ur_‘ls and click [OkK].
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T Review the installation settings and click [Install].
When you have selected [Custom Installation], depending on the Windows OS,
you need to have one of the following USB drivers installed on your computer.
Please select and install the appropriate driver.
* Windows 98/Windows 2000: Canon DV TWAIN Driver
* Windows Me: Canon DV WIA Driver
* Windows XP: No driver is necessary to be installed.

Confirmation —
@ ZoomErowser EX 155 MEB
step2 License o |
& EOS Utility 20ME
Step ation

View a description of the software by passing your mouse over the name of the
software,

C:AProgram Files\Canor,

Click [Install] to start installing.

‘ Back |

2Py When installing the software on Windows 2000 or XP by selecting [Easy
& Installation], EOS Utility (a software for downloading still images from the
Canon EOS Digital SLR Cameras) will be installed. This software is used only

for compatible Canon EOS Digital SLR Cameras, and the camcorder does not
support this software.
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Read the license agreement and click [Yes] to accept the
terms and to start installation.

License Agreement

Flease read the following License Agreement carefully before instaling the
software.

License

IMPORTANT NOTICE
This saftware contains the Adobe color profiles (Adobe RGE{1998), Apple REE,
ColorMatch RGB, Wide Gamut RGE), and which are licensed under the folowing
step 3 Installation Adobe SYSTEMS INCORPORATED COLOR PROFILE LICENSE AGREEMENT, This
software other than such Adobe color profiles is licensed under the Following
Canon Software License Agresment.

stepd  Finish = -
CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE! This
document is & legal agresment (" Agreement”) betwesn vou and Canon Inc.
{*Canon") and gaverning yeur use of this software, and online manual or ather
electranic documentation, and sound daka and image data, I any (the "Software").
BY INSTALLING THE SOFTWARE, ¥OU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT. IF YOI DO MOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY STOP THE INSTALLATION PROCESS,

1. GRANT OF LICENSE

(1) Canon grants you a nan-exchusive license ta use ('use’ shall mean staring,
loading, instaling, executing, or displaying) the Software on your camputers solely

For use with Canen product. Vou may allow other users of Canon's product touse v

Click [*es] to accept the License Agreement. If you click [Mo], the installation
of Digital Wideo Solution Disk will be canceled.

Click [OK].

ZaomBrowser EX.
I Installed
|| m Jadll EOS Utility
./ Installed
Installation
 ZoomBrowser EX

o EOS Utility

stepd  Finish
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10 When the installation is complete, select [Restart computer
immediately (Recommended)] and click [Restart].

Installation of the software has been completed.

( Restart computer immediately (RetnmmendedD

Finish

2¥q When you do not need to restart the computer, the [Finish] screen will be
& displayed. Click [Finish]; remove the DIGITAL VIDEO SOLUTION DISK from
the CD-ROM drive, and proceed to Before Downloading Still Images ([ ] 25).

11 When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK
before you connect the camcorder to the computer.

Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN
Driver or WIA Driver have only been copied to your computer. To download
images via USB connection, finish installing the TWAIN Driver or the WIA
Driver. For details, see step 4 ([.[]25) in Connecting the Camcorder to a
Computer.
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| Before Downloading Still Images

Connecting the Camcorder to a Computer

@ O Be sure to install the Digital Video Software before you connect the
\ o /| camcorder to the computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

o The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

o Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

7Py © Refer to your computer manual for the location of the computer’s USB ports.
4 0o See your camcorder instruction manual for connecting instructions.

1 Insert a memory card containing images into the camcorder.
2 Connect the power adapter to the camcorder.

Turn the POWER switch to PLAY and move the TAPE/CARD
switch to CARD.

Wait until the card access indicator stops flashing.

.~

Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
* The first time you connect the camcorder to the computer:
- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV
WIA Driver (Windows Me) starts.
- If the “Digital signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.
* Windows 98/Windows 2000/Windows XP: A window appears allowing you to
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to
close the Wizard.
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* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images (ZoomBrowser EX) ([ 1] 27).

USB Terminal USB Cable

~¢— Camcorder End Computer End —»

USB Port on
the Computer
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| Downloading Still Images (ZoomBrowser EX)

@ o Observe the following precautions when the camcorder’s access indicator is
¥ flashing. Failure to do so may cause memory card data to become
corrupted.
- Do not open the memory card cover, remove the memory card or detach
the USB cable.
- Do not turn off the camcorder or the computer.
- Do not change the position of the POWER or the TAPE/CARD switches.

O Images recorded onto memory card or downloaded to the hard disk are
important original data files. Create a copy of the file first before working on it
on your computer.

O Do not rotate the image in the [Windows Picture and Fax Viewer] or in the
explorer view. The data for the original image will be changed and the image
can no longer be displayed in ZoomBrowser EX or on the camcorder.

o If the Server Busy window appears when you connect the camcorder to the

computer, click [Retry].

Thiz action cannot be completed becauze the ather
' program iz buzy. Chooze "Switch To' to activate the
“ buzy program and correct the problem.

O You cannot connect the camcorder to a computer if the memory card
contains more than 1800 images. In this case, use a card reader/writer to
download images.

- For instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer (1] 36).
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Starting CameraWindow

1 Connect the camcorder to the computer ([1] 25).

2 Select [Canon CameraWindow] and click [OK].

« If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon ¥ & ¥ %

Camera connected

Select the program to launch for this action:
=N
@J B (5P

Canon EOS Ltility
Downloads images from EQS camera

<Ts Microsoft Scanner and Camera Wizard
Clownload pictures from a camera o scanner

[ &lways use this program for this action

» The Camera Control window opens.

&L CameraWindow - Canon #3k F 4 4

'Acquirelmages Print Settoaﬂera Fiemote shooting

Downloads uzing camera

‘1' & Q&N Press the camera's button

L

Downloads using computer

@l Starts to download images

| =

= i
j;?—l Lets you select and download images

[] Displays this screen when the camera is connected

2% © If the camcorder is already connected to the computer, you can start the
& CameraWindow and display the Camera Control window by clicking [Acquire
& Camera Settings] followed by [Connect to Camera] in the ZoomBrowser
EX Main Window.
o The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images

You can select a downloading method in the Camera Control window.

B Auto-Downloading

1 Click [Starts to download images] in the Camera Control

window.

* For instructions on how to set the Auto-download settings, see Auto-

Downloading Settings ([ ] 30).

* Click [Finish] to close the Camera Control window after downloading images.

& CameraWindow - Canon sk ok

Acquire Images | Print | Set to Camera | Femote shooting

Downloads uzing camera

P ] \-‘-’JQN Press the camera's button

Diizplays thiz screen when the camera is connected

Freferences...

Lets you select and download images
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B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon

' | Acquire Images |!3nnt Set to Camera | Remate shooting |

‘ Downloads uzing camera

¥ Q‘QN Press the camera's button

Displays this screen when the camera is connected

| Preferences... |

2 Select [Change auto download settings] and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

() Change direct transfer download destination folder

(@, Change auto download settings )

Cancel
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3 Select the image type to be downloaded and click [Next].

Place a check mark here ——
if you wish the original image

in the camcorder to be
deleted after downloading.

CameraWindow - Auto Download Settingsi1)

Select the image type to be downloaded.

(%) Mew images

() Allimages

(") Images whosze print order settings were specified with the camera

() Images whose transfer gettings were specified with the camera

Download Options

= |'when the download iz complete, the ariginal image iz deleted from the camera.

<Back @  Nest> 1) Cancel

4 Specify the destination folder settings and click [Next].

Destination Folder

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

A new folder will be created far each of the images' shoating dates in the following folder,
and the images will be saved there.

Click this button
to specify the

Browse...

Create Subfolder

destination folder.

Select to specify —
the name of the
subfolder.

-S hooting YeartdanthD ate >

E xample;

Q C:\Documents and SettingshCanon'y Documents'hy Pictures
(21 200%_01_15

< Back Cancel
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5 Specify a process to perform after the image is downloaded.

CameraWindow - Auto Download Settings(3) b_<|

Specify process to perform after image is downloaded.

(%) Display the folder at the save destination

() Perform selected processes conzecutively

< Back Cancel

Below window will be displayed when you select [Perform selected processes
consecutively] (You can redisplay the window by clicking [Select]). Select a
process to perform after the image is downloaded, and click [OK].

Select Process

Pleaze select a tazk to run after pour images
have been downloaded:

%) View as a Slide Show
() One Photo per Page Frint
() Index Frint
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6 Click [Finish].

CameraWindow - Auto Download Settingsi4)

Enable or disable the image auto-download function. E

PIaCing a CheCk mark | Images are automatically downloaded to computer while camera iz connected
here makes images in
the camcorder to be
automatically downloaded
when the camcorder is
connected.

< Back Cancel

B Downloading the Selected Still Images from the CameraWindow

1 Click [Lets you select and download images] in the Camera
Control window.
The CameraWindow opens.

& CameraWindow - Canon ok ks
Acquire Images | Print || Setto Camer;"&mote shioaoting

Downloads uzing camera

W ] \T-’JQN Press the camera's button
[ —

%QJ Lets you select and download images

Diizplayz thiz screen when the camera is connected
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2 In the CameraWindow, select the image you wish to
download and click [Image Download].

« Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

« Clicking on different images while holding down the [Ctrl] key selects multiple
images.

& CameraWindow - Canon 4k

File(F) Edi(E) View(t) Help(H)

=N \is. = 2/ Fie Information
‘..‘é‘ Image Download d Print - Start ZoomBrowser £

FileName:  IMG_0101JFPG

j 2 Modified: 20001715 14:49.28

File Size: B0KB
Image Gize: Bd04E0

_# | Histogram

B Select - c

- = E o A0
Ablue frame—ﬁ vl F

appears around
the selected image.

IMG_0101JPG IMG_010ZJPG IMG_0102.JPG IMG_0104.JPG

2 Details:

[ ——

Ttem Name Value &
File Name: MG_010
Camera Modsl ... Canon
Shooking Date/Ti... 1§15/200
Shooking Mod=  Partrait
Phato Effect Off

Tv (Shutter Speed) 1j40
Av Aperture Yl 2.0

Light Metering Evaluativ
Exposure Comp...

150 Speed Auto

Lenis 2.6-65.1
Focal Length 7.9 mm
Digital Zoam Hane
Image Size G460
Image Qualty Fne &
S >

Selects image 1 of 4

3 Confirm the settings and click [Starts Download].

« ZoomBrowser EX starts, and the downloaded images appear in the Main

Window.
Camera¥Window - Download Images
i —
__;‘“ -) Download images according to the following settings.
Specify Folder
Sawve to [Folder Mame]
. CADocuments and Settingz\Canoniy Documents
Setting for the folder and the
. Create Sub Folder
subfolder for downloaded images
Shooting TeartonthD ate
| Specity File Mame \
Settings for the ﬁlle prefix 1 Do nat modiy
and the consecutive numbers J
[ Change Settings... l
/\
Z( Starts Download )j I Cancel l
\ /

» To make changes, click [Change Settings].
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[Specify Folder] Tab

Cameralfindow - Change Settings

SpeCIfy the Settings of Specify Folder | Specify Fil: Name |
the folder and subfolder.

Save to [Folder Mame)

|E:\Documents and SettingztCanonky Documents | L Browse. . J

& subfolder into which the image will be saved will automatically be created in this folder.

Create Subfolder
|Sh00ting YeartdonthDate vl

Mew Mame

|='—.\' AGE |

Example:

[:. C:ADocuments and Settingz \Canon'by Documents
-] 200%_01.15

ak. ] [ Caticel

[Specify File Name] Tab

CameralWindovy - Change Settings

Specify the file name at — o= Specity Fils Name |
which to save the images.

Specify File M arne:

IMiG

Azzign Sequence Mo

4

MHurnber of Digit

Example

[RRSRIESE terizion will be the zame agiB Cnainal file name]

ok, ] ’ Cancel
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B Using a Card Reader/Writer

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For instructions
on how to connect the card reader/writer, please refer to its manual.

29y If your card reader/writer does not support miniSD cards, please purchase an
& appropriate adapter for the card. If you are using SDHC cards, you need to use
a card reader/writer compatible with SDHC cards.

1 Insert a memory card containing images recorded with the
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows
[Start] menu, and select [Programs], [Canon Utilities],
[CameraWindow], [CameraWindowMC] and
[CameraWindow].

Windows XP: When a window appears allowing you to select
an application program to start, select [View/Download
Images using Canon CameraWindow] and click [OK].

2Py Clicking [Acquire & Camera Settings] » [Acquire Images from Memory Card]
‘A in the Task Area of the Main Window of ZoomBrowser EX also opens the
Camera Control window.

3 Select a downloading method.

* [Starts to download images]: The progress bar will be displayed and images
will be downloaded to the computer, and ZoomBrowser EX starts. For
instructions on how to set the Auto-download settings, see Auto-Downloading
Settings ([_] 30).

* [Lets you select and download images]: The CameraWindow opens,
displaying the camcorder images as thumbnails (small images).

f«’ CameraWindow - G:ADCIM

Acquire Images | Pript

Starts to download images

Lets you select and download images

J
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Using the Camcorder to Download Still Images (Direct
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the camcorder to
download images.

B Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

Acquire Images | [3rint | Set to Camera | Remate shooting

Downloads uging camera

o \-'-’J&N Press the camera's button

|l Lets you select and download images

Digplays thiz screen when the camera is connected

| Preferences... |

2 Select [Change direct transfer download destination folder]
and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

(@ Change direct transfer download destination folder )

(") Change auta downlaad setings

: Back Cancel
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3

Specify the destination folder settings and click [Finish].

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder
A new folder will be created far each of the images' shoating dates in the following faldar,

and the images will be saved there.

C“Ck thlS button Browse...

to Specify the Create Subfolder
destination fOIder. Shioating "earkd onthD ate v
E xamplz:
. 1 C:\Documerts and Settings\Canonthy DocumentssMy Pictures
Select to specify —— 200k 018
the name of the
subfolder.

< Back Cancel

B Direct Transfer

1

Select a transfer option on the camcorder screen and press
the D~ button.

» See your camcorder instruction manual for how to set and operate the
camcorder to transfer images.

« The [y button cannot be used when it is not lighted.

* You can set the action that is carried out for direct transfer. Right-click the
[CameraWindow(Launcher)] icon on the taskbar and select an action from the
displayed menu.

- [Show image(s) in fullscreen . o
model]; v Show image(s) in fullscreen mode

Displays downloaded images in | .+ Launch ZoomBrowser Ex
full screen mode. —

- [Launch ZoomBrowser EX]: I'v Show Windaw

Starts ZoomBrowser EX after

downloading the images. Abouk CameratwindoveLauncher). ..
- [Show Window]:

The Camera Control window Exit

appears when you connect the
camcorder to the computer.

Press the [0,~» button on the camcorder.
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| Printing Still Images

Printing Still Iméages Recorded on the Memory Card E

You can select one of the following 4 methods to print still images in the card without
downloading images to the computer.
* [Print All Photos]

- Prints all still images recorded on a memory card in the connected camcorder or in

a card reader/writer one image per page.
* [Print Contact Sheet with All Photos]

- Prints all still images recorded on a memory card in the connected camcorder or in
a card reader/writer in an index (rows of images with file names and image
information).

* [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.
* [Select an image and print]

- A list of the still images recorded on a memory card in the connected camcorder or
in a card reader/writer will be displayed, and you can select images you wish to
print.

1 Connect the camcorder to the computer. ([1] 25)

2 Click the [Print] tab in the Camera Control window.

& CameralWindow - Canon 4 k4
Arguire |m395m etto Cam?ﬂl_ﬁemote shooting

Downloads uzing camera

3

e \JJ&N Press the camera's button

5 i
j;?—l Lets you select and download images

Diizplayz thiz screen when the camera is connected
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3 Click one of the 4 printing methods.

& CameraWindow - Canon sk ok

Acquirelmages| Frint |Set to Camera | Remote shooting |

— D

isa) | Print All Photos

E;EP Print Contact Sheet with All Photos
o 4 . :
h Print according to DPOF settings

= Select an image and print

\_ J

Diizplayz thiz screen when the camera is connected

4 Specify the print settings and click [Print].

The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

Frinter Frewview

- (& B =
t Trim Image

Canaon D
| AR | Fiotate Left  Ratate Righ

Properies...

(MediaType:

|Plain Faper v|

Faper Size: —

|Letter v|

Orientation:

@ Paortrait O Landscape
\ ),

Taotal: 4 pages
Fage Layout Settings

Auto Trirm

[ Barderless

Select additional information
to print with your images:

[[] Shoating Date
[[] Shoating Time

Text Colar: (|

. - &:
opies: |1 =

4| Image: 1/ 4 E
L

Click this button to switch between still images

Sets the auto trim if multiple images are selected.

(crops image edges

according to the page — Sets the number of print copies of the displayed image.
proportions) or

borderless print settings. =—Sets the shooting date/time imprint and color settings.
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When you have selected [Print Contact Sheet with All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

.. K

Frinter Sreview

Marne: -,:u
|Can0n foaees 7| ) :
Fotate Left Fotate Riaht Trim Image

Index Print Settings

Properties...
Media Type: \‘w,w' F
Flain Paper b 1 ) i
Faper Size: ‘
Letter b -3
Orientation:

@ Partrait O Landscape

-~

Copies: |1 %

Total: 1 pages

Fage Layout Settings

Colurnns: 3

Fuows: 3

43 ()

\_

Shaating Information

[ Header/Footer
. 4 g _— _— =
4 Page: 1/1 »
1 ]
Sets the print settings Click these buttons to switch between pages.

for shooting information,
comments, headers,
footers and page
numbers.

— Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

When you have selected [Print according to DPOF settings]:

* The selected still images will be printed according to the number of copies set with
the camcorder. The same window described in the previous section When you have
selected [Print All Photos]: ([1]41) will be displayed.
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When you have selected [Select an image and print]:

* If you selected [Select an image and print], the following window will be displayed.
Select still images you wish to print, and click [Print]. If you selected [Contact Sheet
Print], the same window described in the previous section When you have selected
[Print Contact Sheet with All Photos]: ([ 1] 42) will be displayed. If you selected [One
Photo Per Page Print], the same window described in the previous section When you
have selected [Print All Photos]: ([1]41) will be displayed instead. Set the print
settings and print the still images.

& CameraWindow - Canon 4k k% |:| \E| FZ|
File(F) Edit{E) Wiew(y) Help{H)

= . ) — _# | File Infarmatior:
;‘r Image Downl:(d L{&ﬁ Print = ﬁ Start ZoomBrowser EX File Mame:  IMG_0101JPG

Modified,  200%/01/1514 4328
= - = =3
et ) Fie Sz BOKE

Image Size:  G40x480

ﬂ Hiztogram:

IMG_0101JPG IMG_D102.JFG IMG_D103.0PG IMG_0104.0FG

5| & Detais:
Trem Mame Yalue A
File: Mamne: IMG_010

Camera Model M., Canon
Shoating DatefTi... 1715200
Shoating Mode Partrait
Fhota Effect Off

Tw (Shutter Speed) 1740

Ay (apertore val,, 2.0

Light Metering Ewaluativ

Exposure Comp... 0O

150 Speed Auko

Lens 2.6 -65.1

Facal Length 7.9 mm

Digital Zoam Mone

Image Size E40x480

Image Cuality Fine v
| < >

Selects image 1 of 4
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Printing Still Images Downloaded to the Computer

You can select one of the following 2 methods to print still images downloaded to the
computer.
* [One Photo per Page Print]
- Prints one still image per page.
* [Index Print]
- Prints selected images in rows with file names and image information.

2Py You can select the program to use for printing by clicking [Print] in the Main
7 . . . .
Window and selecting [Print Using Other Software].

B [One Photo per Page Print]

1 Click [Print] in the Main Window and click [One Photo per
Page Print].

{7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures
File Edit View Tools Internet Help

[ Tasks @ ] @ Slide Show {a Search

o f T -
ol Acquire & Camera Settings Zoom Made | Scrol bode I Freview MUdE..

My Pictures € > 4 :-[-}' Q- i_T_-i@a Jr—"""'
W Wiew & Classity [ 1

5 200£_01_15

3 o
N L

’—VI .

)

_—=

| One Photo per Page Print

Index Prink

/

Frint Using Other Software

l Intemet

2 Select still images you wish to print and click [Printer and
Layout Settings].

1o ZoomBrowser BX - C:\Dpcuments and SettingsiCanoniMy Documentsiy Pictures

Help

Zaom Mode | Seroll Made | Preview Mode | i =
| . € > 4+ |H-0-|x& | 5T Fiter Tool

¥ 200%_01_15
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3 specify the print settings and click [Print].

Sets the paper size and orientation. Rotates still images.

Selects the printer.

Click this to use the trimming function
(crops a portion of the still image).

BEE

Frinter

1 Marme:

Printer and Lavout Settings [
| Canan x0ooe

< |3 Print > Froperties

Media Type:

| Plein Paper b
\ p |

1 Faper Size:

‘ Lettar A ‘
1 Return to Main Menu e

Orientation:

@ Farrait O Landscape

Taotal: 4 pages

Fage Layout Seftings

Auto Trim
[ Borderless

Select additional information
to print with your images:

] Shooting Date
] Shooting Time

TextCalor: [N

| 4 Image: 174 »
| |

Click this button to switch between still
images if multiple images are selected.

Sets the number of print copies of the displayed image.

Sets the shooting date/time imprint and color settings.

Sets the auto trim (crops image edges according to the page proportions) or borderless
print settings.

Printing Still Images 45



B [Index Print]

1 Click [Print] in the Main Window and click [Index Print].

&1 ZoomBrowser X - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

[ Tasks

L Acquire & Camera Settings
@ Wiew & Classify

[@ Edit

W@ Export

l% Prirt

J — Wiew Image |_':'_‘ Propetties @S\ideshow @ Search | Delete } Rotate
Lﬂne Phaoto per Page Print J
<]
|

Zoom Mode | Scroll Made | Preview Made|

My Pictures € + R-0- |I|®§ 4 J—_ A7 Filter Taol

| Index Print

FII \|

rPnnt Using Other Software

S |

A

IMG_0103.PG  IMG_0104.1PG

2 Select the still images you wish to print and click [Printer
and Layout Settings].

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documentsiy Pictures

File Edit Wiew Tools Internet Help

Zoam Mode | 5 croll Mode | Preview Mode |

o o

My Pictures

e [ T FiberTool

3 Return to Main Menu
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Specify the print settings and click [Print].

Sets the paper size and orientation. — Rotates still images.

Click this to use the trimming function
(crops a portion of the still image).

&7 ZoomBrowser, EX - C:\Documents and SettingsiCan| piby Documents |l|\E\|Z|
File Edit View Tools Intermet Help
Help

Selects the printer.

ndex Print

l | Frinter

1 1. Select Images

MName
l Printer and Lavout Settings ‘ Canan v

- _D
Media Type:

1Plam FPaper V‘

Faper Size

lLeﬂer V!

| 99 Retun to Main Men:

Orientation:
©Ponrait O Landscape

opies |:ﬂ

Taotal: 1 pages
Fane Lavout Sefings
(Culumna 13 ii
kRDWS }3 :!

Shaooting Infarmation

Setlings..

[ Header/Foaoter

| 41 Page: 1/1

p—
b

Click these buttons to switch between pages.

Sets the print settings for shooting information, comments, headers, footers and
page numbers.

Sets the number of rows and columns.

Sets the number of print copies of the contact sheets.
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| Organizing Images

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars. The
Star Rating can be used as one of the search conditions, or for the selection of images
to be displayed in the Browser Window. The keyword can be used as one of the
search conditions.

1 Select the image to which you wish to apply the Star Rating
or Keyword, and select [View/Modify Keywords] from the
[Tools] menu.

e =8 Inkernet  Help

_ustomize. ..
|_ Preferences...

2 Place a check mark next to the keyword you wish to apply,
or click on the stars for rating.

o ViewiModify Keywonds

Check or uncheck the bawes to change the way Kewwards are applied ta the selected files. To add a new Kepword, type the name in the
text field belovs the desired category, and press the + buttan.
People: Flaces: Events: Others: )
[ children [ Beach [ Bithday

[ Family [ Citye [ Holiday

[ Friends |UHOme [ Party
— J/
Select the star rating to assign to the selected files

P e Reset
Cancel

2Py © The default setting of the Star Rating is two stars.
4 © You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

[ Tasks Q|| B vewmaze [E] propeties @S\ide Show @ Search

I i
t@ i B J Zoom Mode | Scroll Mode ‘l Preview Mude|

My Pictures < ﬁ m s 0 7

(x]& & et [ F Fiber Tool

@ Wiew & Classify

—
1
1

rI \
J

¥ 200%_01_15

Rk

l@ Export
l@ Print
| l Irtermet

IMG_0101.0PG  IMG_D102.0PG

File Edit View Tools Internet Help

H I 7 Q” witiese B Proverte () s how @Search

Zoom Made |S:r0|iMUde | Preview Mode |

| @ Acquire & Camera Settings

My Pictures € Q [ﬁ T 0 &z

=
I Wt—é_} Wiews & Clagsify

Wiew g a Slide Show

Lﬂeﬂame hultiple Files

Claszify into Folder

rSeamh 7

¥ 200%_01_15

| e

VAR
\_/I

3 Select the images you wish to classify and click [Specify

Classification Settings].

Zoom Made Scrol Mode | Previeu\;}ﬁudél

Select Images

My Pictures: € Q l-ﬁ 0

{ 2 Spec\fy Classification Settings
L

3 Firizh

T

(

| U5E IMG_0102.IPG
| [ 3 Retun to Main Menu ]
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

7 ZopmBrowser BX - C:\Dpcuments and SettingsiCanoniMy Documents

File Edit WView Tools Inkernet Help

ity into Folder STEP if ificati

J 1. Selectimages ? faecify Folder Struclure When classifying by shooting \
b - Specify folder structure date, ZoomBrowser Exwill anly

Specify Classification Settings 3] classify photos with shooting

_1 A ‘YearMnthate V| clate information and skip over
————— = =
. =3 " photos without shooting date

‘ Finish D E‘ . "J Example Folder Structure: information.

| E‘J [a CADocuments and SettingsiCanoniiy Documents |
200%_01_15 By default. ZoomBrowser Ex

copies the ariginal photos to the
nesw folders, To save space on
wour computer. choose to move
the photas instead

I Return to Main Menu

Seve ta Folder

] ‘Wwhere would you like these folders to be created?

© Current Falder
O My Pictures

O Specify Folder

C ‘\D"U cumeﬂl‘s and“‘S etti‘ngs\C‘anUn\M;‘: ﬁucumems

«1\«1

Copy or Mowve Images

@ Copy

(%j | O Move /
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and copy
multiple files.

1 click [View & Classify] in the Main Window.

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit Wiew Tools Internet Help

[ Tasks 6] | e Image ‘ Properties @S\ide Show @ Search

I ;
L Acquire & Camera 5 ettings J ZoomMode | Soroll Mode ‘l Preview bods | —
= s €5 2 ®m-0- AR T [ ot |
(=" view & Classity

-
N

|
|

g
o

| l@ Export
| l@ Print
. [ Irtermet

2 Click [Rename Multiple Files].

IMG_0101.0PG  IMG_D102.0PG

t&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures

File Edit View Tools Internet Help

@ Slide Show @ Search

Zoom Mode | Sl Mode | Preview Mode|

My Pictures € L3 | @ -0 - |[I|@“‘ Jr—-f" .]:?:: Filter Taal

¥ 200%_01_15

Q)

=
Eﬁ) Wiew & Clazsify ]
iew a5 & Shide Shiow J
|

Rename Multiple Files

F|| \|

Claszify into Folder

Search

3 Select the images you wish to rename and click [Specify
Rename Settings].

Zoom Made | Scrol Mode | Preview Mode
Select Images !

= = = = My Pictures € t |BR-0- |E|@1‘a Jr—"r_' 5T Fiker Taol

| 2 Specily Rename Settings

L S —

b

3 Finish

;‘J 3 Return to Main Menu
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4 specify the settings and click [Finish].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

] 1. Select Images ‘

L Specify Alename Settings J

~
|

Rename Settings Fienaming your photos can

Selecthow files should be renamed. ::;ergﬁmh'"g U=t EAnEh

@ New Name + Number

O Shooting Date + Number
O New MName + Shaoting Date + Nurber 123.0PG 456.JPG
O Shooting Date + New Name + Number

] hake copies offiles

A_N0TJPG  A_DDZ2JPG

l"|i‘l

Specity name: |HEWHAME

T - By cefault ZoomBrawser EX
MNumber of digits: 3 crestes and renames copies of
T - the original photas, To save

[ 3 Rt to Main Mefu

Start number: 1 SPACE On Your computer,

choose to rename the original

Example of new file name: photos instead.

MEWNAME_001 s
\ MOTE: The original data type (o0 will be retained /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

2Py o rename a folder, select a folder, and open the [Rename Folder] window by
& selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images
This task allows you to search for images by Star Rating, Modification Date, Shooting
Date, Comment or Keywords.

1 click [View & Classify] in the Main Window.

You can also search for images by clicking [Search] on Application Tool Bar.
Please skip forward to step 3.

1 ZoomBrowser EX - C:ADocuments and Settings\Canonky Documents\My Pictures
1=

File Edit ‘iew Tools Internet Help

[ Taske [2] [:Q,:,P slide Shuwl "Q Search '
E@ Acquire & Camera Settings J ZoomMode | Serol Mode | Preview Wode = - = 3
’T,E‘z‘ = = = iy Pictures € 4+ EH-0- ‘Ll'\"—'{ _]rr—""" Lo Filter Tool
I Wiew & Classify |
D oz
%) 200<_01_15
r@ Edit ‘I ”j
l@ Export | = o,
l% Frint | ‘ .
i IMG_0101.PG  IMG_0102.JPG
l Internet |

2 Select folders and images from which you wish to search
and click [Search].

7. ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsidy Pictures
File Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings

Propetties DPS\ide Show [ﬁ Search ﬁ Delete

Zoom Mode | Sorall Made | Freview Mod_§|
= My Pictures + t | @ i o |_|I‘§‘\ ~
L’r@i\ Wiews & Classity Y
Wiew g a Slide Show

Clazzify into Folder

|
|

|

.
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3 Specify the search conditions and click [Start Search].
* The search results are displayed as thumbnails.
* Select at least one search condition.

& ZoomBrowser EX - C:\Documents and SettingsiCanonthy Documents
Fle Edit View Tools Intemst Help

1. Selact Search Region

Specify Search Conditions

| 3 StartSearch

| 99 Retun toMain Meru

=)

STEP 2: Specify the search conditions

’ @ Match all conditians O Match any condition ‘

Star Rating

Find irmages with the selectad star rating

Star Rating: + -

[ Modification Date

Find images based on the date they were last modified

[] Shooting Date

Find images based on the date they were shot.

[J Camment

Find images that hawe comments containing the following words:

Help
-

4 Click [Finish].

[ Keywords
\ Find images you have tagged with keywords. /

» To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

11" ZoomBrowser B% - C:\ocuments and Settings\Canoniy Documents

1l

Select Search Region

Help

2. Specify Search Conditions

L Stant Search
=

1
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» The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder.

Favorite Folders
= [ﬂ My Pictures
% 2o00%_01_15

N Tu s LA o N1
" mad =

Folders Area

[ 1

oys The searched images will remain in this folder until ZoomBrowser EX is closed
4 or another search is performed, but if you delete an image in this folder, the
corresponding original image will be deleted as well.
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| Creating a Movie from the Still Images

Editing Movies

You can link still images, insert text and background music, and add effects. You can
also change the size of selected movies and save them as new files.

VG‘ o If you are not using Windows XP, QuickTime 6.5 or higher is required to edit
\ o/ movies. If it is not already installed on your computer, install it from the
DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.
o If you have an AVI file in your computer, you can use this function to edit the
file.

1 Click [Edit] in the Main Window.

#7' ZoomBrowser BX - C:\Documents and SettingsACanon\My Documentsiy Pictures

File Edit Wiew Tools Internet Help
| = =)
[ Tacks 8] )] slide show Q Search

l@ A S rm e s Zoom Mode | Sorall Mode | Preview hode |

My Pictures € 4+ |B-0-| L3 | & __L—"'__— 5T Fiker Taol

2001 _20

‘fﬁ- Wiew & Clazsify

i
g E dit _
el
2~

l s ] IMG_0107.3 M‘ 0103,

.ﬁr

2 Click [Edit Movie].

7. ZoomBrowser, B - C:ADocuments and SettingsiCanonMy Documentsiiy Pictures

Fil= Edit View Tools Internet Help

il = = ~
[ Tasks ] ,_! Yiew petties DP Slide: Show Q Search £lste ‘
Acquire & Camera Settin } Zoom Mode | Serol Mode | Preview Mode |
= | My Pictures € &R0 ||k |® |t A5 Filter Taol
}a- Wiew & Clazsify ]
\@ ol |
Edltlmage J
~
\ Edit Movie )
| IMG_0107 PG IMG_0108.IPG
E xport
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3 Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures
File Edit View Tools Internet Help

r,f‘ Edit Movie STEP1: Add images. Help
1 b Zoaom Mode | Scroll Mode | Preview Mode |

My Pictures + L3 E' 0 - |L|Q N = J-_ 4,? Filter Tool

Add Images

Arrange

3. Apply Effect

14 Setbudo

1 5 Save l
v

4 Arrange images and click [Apply Effect].

To change the order of images, select an image in the Storyboard Area and click
[Move Left] or [Move Right].

7 ZoomBrowser, EX - C:\Documents and Settings\Canoniiy Documents
File Edit Wiew Tools Internet Help

Edit Maowvie STEF 2: Arrange images.

Arrange 7

To arrange images. select the image and click on the [Move Left] ar [Move Right]

] buttons.
Er==s— - \
7 N [ Move Left JR.. Move Riaht ]
(3 fpol Effect ) [BER[E= r -
—_ e —— = To et the play time or rotation, select the image and click the buttan,

4. SetAudio

8 Sawe [ Plap Time T Hatate M

B Euit

3 Return to Main Menu

Total Time: 00:10

Selected Items: 2

Plays back the movies Storyboard Area

being edited. Displays thumbnails of the
selected images. The images will
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.
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5 Apply effects to the images and click [Set Audio].
When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text,
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.

- [Transition Effect]: Opens the [Transition Effect Settings] window. You can
set the transition effect type and display time, and preview the effect. To set
a transition effect, you need to select a transition box in the Storyboard Area.

7. ZoomBrowser, B - C:ADocuments and SettingsiCanoniéy Documents

Tools  Intermet  Help

effects to images.

Image Effects

1. AddImages O lse imane as is

® Anp\y effects to image.

2. Arange ] @B@ To set the Tekt effect, Filter effect. or to magnify a section, select the image and click the
appropriate button
Apply Effect J g’ | [ 1 i J
~
|

[ =]

i/ =\
L

Tent Effect Filter Effect I agrify Section

When you want to zet the image's Transition effect, select the [Trangition Effect] box and

4. SetAudio click the [Transition E ffect] buttan,

1

5 Save

B Euit ]

6 Set the audio and click [Save].
When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add a MP3 or a WAV
file as background music.

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can
adjust the audio level of a movie or an audio file and apply audio faders. To
set the advanced audio settings, you need to select a movie or an audio file
which you added.

7. ZoomBrowser B - C:\Documents and SettingsiCanoniy Documents
Fil= Edit View Tools Internet Help

=
L!L';'ﬂ Edit Mavie | STEP 4 Set audio.
1. AddImages il s e
(%) Set audio.
\ 2 Arange h Tao add audio, click the [£dd Audio] buttan
s
\ 3 Aoy Efect ‘ s Ed fudic
L b Audin J To set advanced audio zettings, select [Audio] and click the [4dvanced Settingz] buttan,

I ~
Advanced Settings
L. —
Exit 7

)
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Click [Save].
Movies are saved in DCF type files with Motion JPEG/AVI compression.

#1 ZoomBrowser EX - C:Wocuments and SettingsiCanontdy Documents

File Edit Wiew Tools Internst Help

-_ ". Edit Mowvie : the edit results.

Save file
1. AddImages S
2. Amange o
- Save to folder:
C:h\Documents and SettingshCanan'My Documents

3. Apply Efect | g y | B

. Save image lype
4. Sethudio %) Auto-select

() Specily a save image type

|Save image bype:otion]PEG [44])
lImage Size: 320 » 240 [Standard)
[Frame Rate:15 Frames/second
Audio:16 bit, 22,050 kHz, Monaural
Total Time: 00:10

[ S it

Click [Save] button to save the edit results,

I 3 Retum ta Main Menu I

Select this to save as Motion JPEG compressed AVI.

Selecting [Specify a save image type] and clicking [Advanced Settings] allows
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.

Click [Exit].

7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wiew Tools Internet Help

Save file

l 1. AddImages B _l
| =

2 Arange i

‘ 8 “ r Save to folder:

[ 3 Aply Effect | |E'\Dncumenls and Settings\Canoniky Documents | [ Browse ] I

i Save image bupe T i
[ 4 Setdudo | (&) Auto-select
() Specify a save image lype
L Save MorichIPER 1) P advanced Settings

7~ ‘S'a'vé'in'i'a'ge t}pe:MoliDP\JPE‘IG '[}'S«V ]
Image Size:320 x 240 [Standard]

D —f Frame FRate:15 Frames/second

i our T

udic: 16 bit, 22,050 kHz, Monaural
otal Time: 00:10

E Click [Save] button to zave the edit results.

Save

I Return to Main Menu
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Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first scene as
a still image with a (movie) icon.

2% © If you are not using Windows XP and QuickTime 6.5 or higher is not already
& installed on your computer, install QuickTime 6.5 from the DIGITAL VIDEO
SOLUTION DISK.

0 Do not double-click a movie file (.AVI extension) in Windows Explorer. That
will start Windows Media Player, which may not support this file type. To play
back movies, double-click the thumbnail with a movie icon in the Main
Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a
(movie) icon.
[Image Viewer] window appears.

7. ZoomBrowser, B - C:ADocuments and SettingsiCanoniy Documentsidy Pictures

Fil= Edit View Tools Internet Help

= . |
[ Tasks € 1}/ Slide Show “a Search

{;_@ Aecquire & Camera Settings

|

e |
E % 2

|

|

Zoom Mode | Serol Made | Preview Mode
My Pictures € & k i

Favorite Folders | Al Folders

Last Acquired Images
= =l All Tmages
< | |

= #h shooting Date
= znmy n1 o1

IMI_D106 AT

= N Ny o f &
IMW MG_D104. PG
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The [Image Viewer] window is displayed, and the movie will be played back.

You can control (Play back/Stop/FF/RW) the movie being played back with the

buttons shown at the left bottom of the window. If you are using Windows XP,

you can extract still images from the movie. For details, please refer to

Extracting Still Images from Movies (Windows XP Only) (1] 69). El

You can save the displayed scene as a still image.

=] ZoomBrowser, EX - C:3Documents and|SettingsiCanoniby DocumentsiM¥l_0106.A¥I
File Edit “iew Help

® M Q%_j B3] et - Show: |@:E 00 B =&

[y MYI_0106. AT

You can play movies and control the sound volume.
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| Exporting Images

You can change the data type for selected still images and movies and save them as
new files. You can also export selected movies and still image properties to a text file
or copy and rename movies and still images. Furthermore, you can export still images
for use as a screen saver or a wallpaper.

Changing the File Type and Save

1 Click [Export] in the Main Window.

7 ZoomBrowser B¢ - G:\Documents and Settings\Canon\My Documentsiy Pictures

Fil= Edit View Tools Internet Help

[ Tasks

= =
D‘?) Slide: Show Q Search

li@ Acquire & Camera Settings

= —
l |re;— Wiews & Classity

Edit

E

Pririt

l Intermet

IMG_0101.0PG  IMG_0102.0PG

2 Select the export type.
If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], please refer to the pages listed below.
[Export Movies]: Exporting Movies ([1] 66)
[Extract frames from a movie]: Extracting Still Images from Movies (Windows

XP Only) ([ 1] 69)

= =] 4,? Filter Tanl

[Backup to CD]: Saving on CD-R/RW Disks (Windows XP Only) ([1172)

57 ZoomBrowser, BX - C:\Documents and Settings\Canoniy Docume ntsiMy Pictures

Fil= Edit View Tools Internet Help

[ Tasks 6 ] | Tew Image 5 @P Slide: Show @ Search
@ Edit l A Zoom Mode | Serall Made | Preview Made

My Pictures 3 = k-0 k &,
@ Export

Export Still Images

Export Movies

Extract frames from a movie

“fa

Export Shooting Properties

IMG_0101.JRG  IMG_0102.0FG

Export a5 a Screen Saver

Export a3 a‘Wallpaper

Backup to COv

\L

el | 5T Filter Taol

&

200_01_20

a‘l-

| Intemet
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3 Select images and click [Specify Export Settings].

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures
Fil= Edit View Tools Internet Help

Zoom Maode | Scroll Mode | Preview Mode |

My Pictures € 4+ m -0 - |I|Q % = }— 4,? Filter Taal
¥ 2000115

IMG_0101, JPG 8 e uhtaieze

; [ 3 Retun to Main Menu

4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step2.

When you have selected [Export Still Images]:

You can convert still images to another file type, resize and save them as new files.
You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to
be added to the exported still images.

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniiy Documents

File Edit Wiew Tools Internet Help

E’:"E Export Still Images

‘ 1. Select Images ‘ Image Settings ou can reduce the amount of
[ Resize images during export mernary yaurfles use by
Specify Export Settings . resizing the images to a smaller
| - Long side size
il §
~ 7 L EI 200 | pixels
. ) le—sl
\ u : Shorkgide:
k.
= 1| -
kel
[ 1 Rieturn to Main Menu [0 Change image type When exporting images as
[, \,| it — — }— High JPEGs, you can also reduce file

sizes by using a lower Quality
sefting which compresses the
Qriginal File Size: 828KB image more. The images won't

Maodifiad Fis 5 08 KR look ag sharp but the file sizes

will be smaller.

File Mame Settings

Sawveto Folder

@ Current Folder
[ O My Pictures

O Specify Folder

Q\Dncuments and Settings\CanoniMy Documents /
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

& ZoomBrowser EX. - C:\Documents and Settings\Canonihiy Documents

File Edit Wiew Tools Internst Help

Select Images Shooting properties are storad

Selectshooting properties to export: inimages as EXIF information.

Specify Export Settings

Active AF Poinls

&

EXIF stands for Exchangeahle
Image File Format and is used
by most camera manufacturers.

m
=
=)
o
@

il
vl
o
E]
Ir=}
o
=
=]
o
i

[

utnexposure Bracketing
o/ Aperture Value )
Camera Body Mo

Digital Exposure Compensation
[v] Dimital 7aam &)

[ Selectal |[  cClearal |

ETTTETT—

Save to File

= Specify file name and folder:
- ,L

{/! |C\Ducumems and SettingshCan..\ZBShootingPropeties. <t

MNOTE: Properies will be saved as *txt

Files without shooting properies will not he exported /

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

&7 ZoomBrowser EX - C:\Documents and SettingsiCanonty Documents

Fille Edit Wiew Tools Internst Help

ER xpott 5 5 Help

Select Images Screen Saver Seftings =

The order inwhich you select
os determines their
sequence inthe screen saver

g 5 [ Include images in the screen saver (larger file size)
Specily Export Settings

Resize images: 1024768

Ifyou selected ta include
images in the screen saver, you
Screen saver size: 0KB can reduc_e their size to fita
different screen resolution
[JSetas default screen saver
If wou choose not to include
~images in the screen sawver, and
wou then maove of rename these
images, they will not display
when the screen sawer plays

[ Preview Screen Saver... _]

L

YT

Save taFile

ETTTET——

The screen saverwill be saved as

® "ZhSereenSaversor’ in the default Windows directary for
SCreen savers :

‘ O Specify file name and folder SeiEEs.

wTEJhe screen saverwill be saved using the file extension * scr /
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When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents

File Edit Wiew Tools Internst Help

Select Images ( Installation Settings Stretching small photos can \
1] ixelate and distortthe photo

P

Specily Export Settings @ Install centared Try choosing Install centered or
S — __ Installed tiled
TS O Install stretched Tiling replicates the photo. in its

original size. to fitthe deskiop.

O Do notinstall

g O Install tiled

Save to File

| [ T S % The wallpaperwill be saved as:

@ "ZBWallpaperbmp" in the default directary for wallpapers

O Specify file name and folder

\NOTE Wallpapers are saved as bitmap images (*hmp) /
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Exporting Movies
You can change the size or data for selected movies and save them as new files.
70\ If you are not using Windows XP, QuickTime 6.5 or higher is required to export
\&¥4 movies. If it is not already installed on your computer, install it from the

DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.

1 Click [Export] in the Main Window.

{7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures

File Edit View Tools Internet Help

[ Tacks [2) C:DP Slide Show ‘Q Search
@ Acquire & Camera 5 ettings ] £ocm hode STl kioda] (s ek ode) — = =

— My Picturss € t | R-0- |l|@;‘“ Jr—"""
FE?' Wiew & Classity ] [ 1|
L@ - J 200=__20
Il
> = N S
@ Expart ) ‘ ¥
D e —— i

l Intermet
2 Click [Export Movies].

| IMG_0107.1PG  IMG_0108.1PG |

eee— -

¥ ZoomBrowser, BX - C:\Documents and Settings\CanoniMy Documentsikly Pictures

File Edit “Wiew Tools Internet Help

[ Tasks @ ] D? Slide Show @ Search Sﬁ DEle \’ Ru
\@ Edi l & Zoom Mode | Sorall Made | Preview Mode|

& TR O T
Export l [ 1

LExpDrl Still Images J i -

i |

| Export Movies ) || I
— — —( |

Export Shooting Properties ] || | IMG_D‘ gm:@
Export &5 a Screen Saver l e | a2 o i l !

Export as a ‘Wallpaper s F
il
MVI_DID&.AVI

Backup to CDv
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Select a movie and click [Select the save image type].

You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images,
see Exporting Images ([ ] 62).

7, ZoomBrowser B -

C:\Documents and SettingsiCanoniy Documentsidy Pictures

File Edit View Tools Internet Help

Export Movies

Select Movies

Select the zave image type

[ e |

Set the zave image tepe

=

Specify name of file to be saved

s
o

Start export

[ 3 Retun to Main Menu

Zoom Made | Scroll Mode | Preview Mode |

H

My Pictures € 4+ m -0 - |1|Q “ | }‘ 4,? Filter Taal
200__20

IMG_0107 JPG IMG_0108.0PG

IMG_0109.0PG L%

Select a file type and click [Set the save image typel].

&7 ZoomBrowser EX -

C:\Documents and SettingsiCanoniMy Documents

Fil= Edit View Tools Internet Help

l 3 Retun ta Main Menu ]

Save image type

| MotionIPEG [441)

9

[Standard movie fils used on cnrﬁpuiers

'V'ou can et the image size, frame rate and image quality

|\n the nest step,

Rotation settings

r : ) |:|F\otate.
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5 Specify the export settings and click [Specify name of file to

be saved].

=7 ZoomBrowsern EX -

C:x\Documents and SettingsiCanoniy Documents

File Edit View Tools Internet Help

'E.-'_i Export Movies

1. Select Movies

ﬂnage Size

2. Select the save image type

Set the save image type

. Specify name of file to be saved

™~ N N—— 7
l? Start export 7

[ 3 Retumn ta Main Menu ]

(%) No change
() Zoom specification 50%
() Size specification 320w 240

Fix the aspect ratio

Frame Rate
Automatic ~ | Frames/second
Image Quality
-
\) i
Lo Standard High
Audio

\ Automatic b

J

6 Specify the file name and click [Start export].

In each case, specify the destination folder and file name of the movie to be

exported.

7 ZoomBrowser B -

C:ADoc uments and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

narne of file to be

| 3. Setthe save image bype

Specify name of file to be
saved

9 Retumnto Main Menu

7 Click [OK].

File Mame setting —_— = — E— -

(%) Same a3 original image

() Azsign Sequence Mo,

abc |

Save to folder

|E' SDacuments and Settings\Canonhy Documents [ Browse

[Save image twpe information]
Save image lype:Motion PEG [&41]
[Image Size:Mao change

[Frame R ate:dutomatic

\Image Quality: Standard
Audio:Automatic

Destination Folder

The Main Window appears.

MovieExport Task

Export is completed.

@ Details ==
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Extracting Still Images from Movies (Windows XP Only)

You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window. E

&1, ZoomBrowser B4 - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures

Fil= Edit View Tools Internet Help

[ Tasks Q} gl e Tmage :‘ Properties @Shde Show @ Search ! Delete " Rotate

@ Acquire & Camera Settings Zoom Made | Scroll Mode | Preview Mode | .
My Pictures + L3 m -0 - |L|Q 4 J-_ 4,? Filter Tool
@ Wiews & Classify

|

|
£ ol
c—— g
G |

IMG_0107.0PG  IMIG_0108.JPG

E* ——

2 Click [Extract frames from a movie].

Fil= Edit View Tools Internset Help

I [ Tasks 6 ] Wiew Image Properties @ S\ide_show @Tearch

\@ o l: Zoom Mode | Scral Mds | Preven Mode|

l @ My Pictures + LRER A RN = [ P FiberTool
Export l
)

200:_M_20
E=port Still Images

Ekpart Movies J

Export a5 a Screen Saver

Export a3 a‘Wallpaper Jl u|
i
Backup to COv
J  [@) 200%_01_25
e
4

3 Select the movie from which you wish to extract still images
and click [Set extraction method].

17 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiby Pictures

File Edit View Toaols Internet Help

Help

L Select movie J

= e — My Fictures € 4 K-0- |l|'3'4;7 Jrr:!.ﬂf J5F Filter Taol
[ 2 Setestraction method J
E—— 200%_11_20

3. Preview image

4 Setupsave

8 Perform processing

| I Return to Main Menu
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4 select the still images extraction method and click [Preview
image].

* [Extract all frames]: Extracts all frames in the movie as still images.

* [Specify an interval and extract frames]: Extracts frames as still images from a
specified frame range or time interval.

* [Specify the number of copies and extract frames]: Extracts a specified
number of still images from the entire movie. The extraction interval is
calculated based on an equal distribution of the specified number of still
images.

* [Extract a specified image]: Extracts still images from scenes that catch your
attention.

t&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents
File Edit View Tools Internet Help

File: name:p1_0108.441
Play time:00:07.00
Total frames:105
Image Size: 320«240

/ Select how to extract the still images fram the movie. \
(&) Extract all frames

Extracts everp frame in the movie as a still image.

5 Perform processing

4. Setup save 7

() Specify an interval and extract frames

ke, Specifies the interval at which stil images are extracted from the movie.
I
e

) Specify the number of copies and sxtract frames
b 2= Specifies the number of copies of still mages to be extracted from the mavie

3 Return to Main Menu it =
E’ :- Copies

() Extract a specified image
wiracts the frame you select while watching a preview of the movie as a sti
_9 Exfracts the f lect while watchi I th till
=

\ B = Y

|
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Confirm the still images which will be extracted (images with
checkmarks) and click [Set up save].

If you selected [Extract a specified image] in the previous window, the movie will
be displayed in the upper part of the window. Display the images you want and

click [Add].

= ZoomBrowser EX -

it Wiew Tools Internet Help

1. Select movie

C:\Documents and Settings\Canon\y Documents

2. Setextraction method l

e ]

~
T

Preview image

N

7

Setup save

8. Perform processing

File mane: MY 01 06441
| Play tire:00:07.00

Total frames: 105

Image Size:320x240

Help

Checked: 105 / Shown: 105

[ 3 Retum to Main Menu ]
a-
el

f]

alla Tl

: Changes the thumbnail size.

: Rotates all still images.

selected still images.

Specify the file name and the folder where you wish to save

it and click [Perform processing].

7 ZoomBrowsern X -

1. Select movie

2. Setestraction method

3. Preview image

L Set up save J

— — —
| 5 Perfarm processing D
3 -

L5 reunitonen ]

C:\Doc uments and SettingsWCanoniy Documents,

/F ile Marne \
) Use original movie file name

" abc

) Specify a file name

Save folder

) Save in same folder az onginal movie
%‘O Specify the save folder

Auto folder creation
() Automatically create a folder with the same name as the original movie

Gpec\fy folder name for auto creation

EE %% : Clears or adds check marks to all still images at once.

: Clears the check marks of all the still images before/after the

Help

J

[<Save Contents>

Saved images: 105

Image Size:320:240

|F|equired disk space:bpprox. 2.8MB

iS ave to folder:C:\Diocuments and Settings\Canoniky Documentsh200=_01_20%6Y]_0106
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Saving on CD-R/RW Disks (Windows XP Only)

You can copy and save images to CD-R or CD-RW disks. The shooting information is
copied along with the images.

’0\ This function can only be used on a computer that came with a CD-R/RW drive
\&¥/ as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-R/RW drive.

2 If the following window appears, click [Cancel].

3 Click [Export] in the Main Window.

CD Drive (F:)

Windows can perform the same action each time pou insert
a disk or connect a device with this kind of fils:

(5] Blank CD
what do you want Windows to do?

CD folder|
5 Expl

7. ZoomBrowser, BX - C:ADocuments and SettingsiCanoniMy Documentsiiy Pictures

Fil= Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings

=
:'rg_ Wiews & Classity
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= = ~
petties DP Slide: Show \Q Search £lste

Zoom Mode | Seroll Mode | Preview Mode

€

AV -0 - (| h |9

L—r—"’— 4,? Filter Tanl




Click [Backup to CD].

1 ZoomBrowser BX -

File Edit Wiew Tools Internet Help

C:\Documents and SettingsdCanoniiy Documentsidy Pictures

[ 9]

! Dekte 3R

Wiew Image:

=) [
E‘ Properties @S\ide Show @ Search

Rotate

Export

-
E

Export Still Images

[ Export Movies

Extract frames from a movie

Export Shooting Properties

Export &z a Screen Saver

Export as a Wa\lpaper

£ ¢ I U FE F F |

=
|

Backup o CO

Pririt

\‘.
.\

Zoom Mode | Soroll Mode | Preview hode |

t |B-0-

My Pictures +

(x]® &

[ T FiberTool

IMG_0103.JPG  [MG_0104.0PG

200%_01_20

Select the folders or images you wish to save and click
[Specify Backup Settings].

Select Images

-

i\l
-

L]

2. Specify Backup Settings

3. Start Backup

|

[ 3 Retunto Main Menu

4,? Filter Tanl

Zoom Made | Serall Mode | Preview Mnde
by Pictures €12 4 m 0 T | Q
¥ 200%_01_15

»
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6 Set the backup settings and click [Start Backup].

The disk will be ejected from the drive when copying is complete.

& ZoomBrowser EX - C:\Documents and Settings\CanonkMy Documents

f Backup Setings The speed at which your \
computerwites (hums) data to

|
.
=

>~ CD Title: ‘ | In general. slower recording
3. StatBackup speeds create CDs that are less
o —_ Speed: ‘Faslesl "| prone to errors.

File Edit Wiew Tools Internst Help

@ Backur

1. Select Images

—_—

[ Verify after backup. ltis always a good idea to
choose "erify after backup' to

Use the Verify feature to testthe data on the CO-R after backup is ansure thatthe backup was

complete. This will take longer, butwill determine whether the backup was successiul

successful

Space on CO-R

{9 Rstun o ain Merw Usad 000 B, Curmant Session 122 &1 KB, Remaining 702 70 ME

(] )

100 300 400 500 600

(1) The file sizes abowe are estimates anly. The CD burning process
may not be completed i the remaining space is low,

\o J

You can add images to a CD-R/RW disk that already contains images.

O
4
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Adding Still Images to the Memory Card in the
Camcorder

You can add still images (JPEG) from the computer to a memory card in the
camcorder. E

'0\ When using this function, you cannot add the still images to a memory card
\&¥] using a card reader/writer. Please insert the card to the camcorder to add
images.

B Adding Still Images to the Memory Card

1 Connect the camcorder to the computer (11 25).

2 Click [Acquire & Camera Settings] in the Main Window.

1 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsibdy Pictures

File Edit Wiew Tools Internet Help

[ ks @ ] lrjP Slide: Show \'a Search
| e e — ~ I - =
\L@ Acquite & Camera Settings Zoom Mode | Scroll Made | Preview Mode .
[ & &
5 200X_01_15

\@ Piirt
[ Irtemet =

3 Click [Connect to Camera].

Lr_'_,_»l‘ e — = My Pictures € + :”k' 0- | j"_“ _Lr"""‘
Wﬁ View & Classily 7 I i

[@ Export
IMG_0101,PG ’m‘
| ol

7 ZoomBrowser, EX - C:ADocuments and SettingsiCanon'dy Documents iy Pictures

Fil= Edit View Tools Internet Help

[ Tasks ':* i
=

@ Acquire & Camera Settings L — — ::
e S T |_k___:"!”§ J,—-—""‘ J5F Filter Tool
| Corines t to Carners 1
s

Corinect to EOS Camera

Acquire Images from Memory Card

=
=" View & Classily

CE

ﬁ
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4 Click the [Set to Camera] tab and click [Uploads images to
the cameral.

& CameraWindow - Canon % ¥4 %

Acquire Images || Print 'J Set to Camers |!Qemote shootinﬁé

Set My Camera

= b

Confirms{changes camera settings

= :
:@’l Uploads images to the camera

Diizplayz thiz screen when the camera is connected

5 Select the still images you wish to save and click [Open].

Upload Images from Disk @
Look in: | £ 20004 01_15 N A
ME_0101 IMG_0103
"F\Ie name: Tﬁ_@ﬁ_m m.PG"
Files of type: IEM _v“
6 Select the image size and click [Add].
Add image gl

Image will be added after setup 1z performed.

(%) Add image &z iz
() Send after changing the image to VG size [B404480 dats)

Cancel

'0\ When you upload images edited with another application, images properties
\&¥ may be lost.
6 |
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B Adding Sample Images to the Memory Card

If your camcorder supports the Card Mix function, you can save sample images for
CARD LUMINANCE. The sample images are provided on the DIGITAL VIDEO

SOLUTION DISK
’0\ The sample images provided on the supplied DIGITAL VIDEO SOLUTION E
\&¥] DISK are intended only for personal use with this camcorder. Do not use these

sample images for other purposes.

Connect the camcorder to the computer ([17]25).

1
2 Insert the DIGITAL VIDEO SOLUTION DISK to the
computer’s CD-ROM drive.

If the installer panel opens, click [Exit] to close it.

3 Click [Acquire & Camera Settings].

7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsidy Pictures
File Edit View Tools Internet Help

[ Tasks @ ] . @ Slide: Show a Search

‘L@Aq e & Comera Seting Zoom Mode | Soroll Mode | Freview Made

) L
I""';- e —] My Pictures € 4+ | K-0- ijj@e J-r"‘"‘
= View & Classity 7 B i

¢} 200%_01_15

1&12 PG

4 Click [Connect to Camera].

7 ZoomBrowser EX - C:ADocuments and SettingsiGanoniMy Documentsiby Pictures
Fil= Edit View Tools Internet Help

[ Tasks @} 1" Wiew Iri Eigs DP Slide Show \a Search lil_"]‘ e
@ fodite & Camerd Seftings Zoom Mode | Scroll Mode | Preview Mods | _alF —— L.
_—_—— == My Fictures g -0 - |_~__:"!'{ J—-—-f‘"" J5F Filter Taol
) _— il
D R — —
Corinect to EOS Camera 7
Wl
Acquire Images from bemomy Card
=
[P view . ciassity ] ’ /
l@ Edit } I | MG_0101.0RG  IMG_0102,IPG
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5 Click [Uploads images to the camera].

& CameraWindow - Canon %k ¥

Acquire Images | Print | Setto Camera | Remate shooting |

Set My Camera

e

Confirmsfchanges camera settings

Uploads images to the camera

[Diizplayz thiz screen when the camera is connected

6 In [Look in:], select the CD-ROM icon, and double-click [DVC
CARD IMAGE].

Upload Images from Disk E]
Laokin: | (B0) CanonD¥Cixxw [E1] e e e=E
I/ -~
MANUAL QUICKTIME
\ v
File name: | ! [ Open I
Filess of ype: i ipeal® ipa) b ' [ Cancel ]

4 Select the sample images you wish to save and click [Open].

Upload Images from Disk @E|
Lagk in: | () CARD LUMINANCE v o e m-

A

2

File rame: [“4UT_D01T.JPG" “AUT_0009.JPG" "alIT_001 |
Filess of type: i\peg[" ipal vl Carcs)
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8 In the Add image window, click [Add].

The sample images are saved in the memory card.

x)

fdd image

Image will be added after setup iz performed.

(3) Add image as is
() Send after changing the image to VG4, size [B40:480 dots]

Cancel
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| Using Various Functions

Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

’0\ To use this function, the e-mail software must be enabled as MAPI client. For
\&¥ details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

#7' ZoomBrowser BX - C:\Documents and SettingsACanon\My Documents\y Pictures

File Edit View Tools Internet Help

= =)
[ Tasks [ 1}/ Slide Show \Q Search

\l’@ Acquire & Camera Settings

Zoom Mode | Serol Made | Preview Mode ‘

= ] My Picturss € t R-0-| &8 _L————"‘ A5 Filter Taol
[ = Wiew & Clazsify ]

¥) 200X _01_15
EE il

S e

—
E{j Irtemet IMG_0101.0RG  IMG_0102.IPG
—_— g r——— |

2 Click [Email Images].

#7 ZoomBrowser BX - G:\Documents and Settings\Canon\My Documentsiy Pictures

File Edit View Tools Internet Help

[ Tasks [) ] pEtties @Shdeﬁhnw Q Search J Dielet: ste

l@ Acquire & Camera Settings

‘.'fg_ Wiews & Clagsify
[@ Edit

=
&~

|

|

l

|

J ,
{@ Intermet J IMG‘mg IMG_0102,

\

— g
| Email Images
== = A | = |

Zoom Mode | Serall Mode | Preview bode | |

My Picures e &-ol[]a T [T PRt |
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Select the still images you wish to send and click [Change

Image Size].

SIS

&1 ZoomBrowser B4 - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

Fil= Edit View Tools Internet Help

o
’{@ Ernail Images

Select Images

Zoom Made | Serall Mode | F‘revle;Mnde!

‘ Iy Pictures L

<2 Change Image Size

3 Sendor Save

2 H-0-[[x]®

}_ 4,? Filter Taal

3] 200%_01_15

4 Finish

| [ 3 Retun to Main Menu ]

i

IMG_0103.JPG  IMG_0104.0PG

Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images
unchanged]. Normally select [Resize and compress images into JPEG type].
- [Long side/Short side]: Selects the long or short side and sets the image size

in numbers.

- [Quality]: The lower the quality, the coarser becomes the still image and
smaller the file size.
- Pressing [Calculate] displays the file size after the compression as [Modified

File Size].

- You can check the compressed still image by pressing [Preview Images].

ernet  Help

| 9 Retun to Main Menu

7 ZoomBrowser EX - C:ADocuments and SettingsiCanon\y Documents

Image Settings

b

© Sendimages unchanged
) Resize and compress images inta JFEG type

© Long side:
I_ EI:I 2Ll 7\ pixels
i
© Shart side:
= S
Ilzl EI 60 | pixals
bl
Cluality: D Highest

82.8KE
0.0 bytes

Qriginal File Size:
Madified File Size:

your email program. A total size of 300KE is recommended

\_

1) wWhenthe image size is large, the images may notbe sent propely by

i
and/or quality of the photos to a
totalfile size of less than 300 KB.
This insures that people can
recense your email

'ou may want to reduce the size

Decrease the file size ofthe
exported photos by reducing
the dimensions. ZoomBrawser
EX maintains the phota's aspect
ratio during resizing,

“ou can also reduce the quality
ofthe photo. The image may not
look as sharp. butthe file size
will be smaller.
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5 Select to send still images by e-mail or to save the still
images in a folder and click [Finish].

* If you selected [Create a new email], your e-mail software starts and the
selected still images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail software
not supporting MAPI does not start automatically. In this case, select [Save the
images in a folder...].

* If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still image
to a message.

1 ZoomBrowser EX - C:\Documents and Settingsi\CanoniMy Documents
Fle Edit View Tools Intsmet Help

itto send later Help

l 1. SelectImages Email Settings If wour email program supports
WM&PI, you can attach the photos

directly from ZoomBrowser EX,

@ Create & new email

l 2. Change Image Size

|
|
L Send or Save J

(%) This option is only svailable if you use an email program that
supports MAPL e.g. Microsoft Outlook Express

Otherwise, you need to save the
photos in afolder, startyour
email program, and then attach
() Save the images in a folder to send through an email program thet does the photos to & new email.

not support MAPL

Then:

1. Startyour preferred emsil program.
2. Aftach the images to an email as normal and send.

3 Retum to Main Menu
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Running a Slide Show

You can view selected still images in a slide show.

1 Click [View & Classify] in the Main Window.

You can also view a slide show by clicking [Slide Show] on Application Tool Bar.
Please skip forward to step 4.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

‘ [ Tasks [2) ‘ B viewtmege  [BE| proper (@ Slde Shnw] @ Search Delete ([ Rabate

E@ Acquire & Camera Settings J ZoomMods | ScrolMode | Previzw Moce — —
| = — My Pictures € Q |—S = 0 2 |l“‘3& J,—-—-—""‘ 4,? Filter Toal

¥ 200¢_m_15

@ Slide: Show @ Search E_ﬁ CEISEE.

ZoomMode | Scroll Mode | Preview Mode|

by Pictures * > t E‘E i ﬂ & |E(R Jr-——""' 4,? Filter Tanl

3] 200%_01_15 L ]

Zoom Made | Serol Mods | Preview Mods

Rename Multiple Files

Clazzify into Folder

Search

Help
Jr—-'-f" ,f?:ﬂ Filter Tl

Select Images

My Pictures

=
| 2 Setup Slide Show
I

3 Start Slide Show. .

e e e e e R A e

j'[ I Return to Main Menu } JH

Using Various Functions I 83



4 select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or
title.

* [Advance to Next Slide]: Select to advance manually or automatically. When
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
itin a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

=7 ZoomBrowser, EX - C:\Documents and SettingsiCanonih

File Edit Wiew Tools Internet Help

| STEF Z: Slide Show Setup

Vie de Show
1. Select Images | f Slide Show Settings \
— oo

|
|

3. Gtart Slide Show. l

Image Size: O Adtual Size
@ BestFit
I R e e e O Maximum Stretch
Image Informetion, Mo Information

& Shaw Information
O Controls Only

Advance to Next Slide: @& On clicking the left mouse buttan
O Every 3 second(s)

gt = — - )

B Click [Start Slide Show].

Click [z} in the lower right corner to end the slide show.

84 I Using Various Functions



Adding Sound to a Still Image

* You can add a sound to an image. The sound file needs to be in WAVE type
(extension “.wav”) or in MIDI type (extension “.mid” or “.midi”).
» The sound cannot be played back on the camcorder. E
1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

28 Wiew Tools Intermet  Help

Copy Chrl+C
Copy ko Folder...
Miowe to Folder. ..
Select all Chrl+a
Cleat Selection Chrl+R

Rotate Image. ..
Rotate According ko Raotation Information

Change Star Rating

UT

Edit Image. ..
la Manage My Camera...

2 Click [Add].

0k ] [ Cancel

3 Select the sound file and C|ICk [Open].
4 ciick [OK].

» The sound file will be copied to the same folder as the image.
* To play back the sound, select an image with a sound icon and select [Play
Sound] from the [Edit] menu.

2Py O To remove sound from an image, select [Remove] on the Sound window in
&7 step 2. ' disappears and the copied sound file will be deleted.
o The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the

Camcorder

You can change and confirm the owner name of the camcorder.

1 Connect the camcorder to the computer ([ 25).

2 Select [Canon CameraWindow] and click [OK].

Canon ¥ ¥ %% ¥

Camera connected

Select the program to launch for this action:

o anon Cameratsindow

pt Y- _ -
aall[ 0hloads Images Fram Canon Came

L

""\I—__.I._ Canon EQS Utility
¢ [ ownloads images from EOS camera

T Microzaft Scanner and Camera Wizard
Dowwnload pictures from a camera or scanner

[ &shways uze this program For thiz action

|

3 Click the [Set to Camera] tab and click [Confirms/changes

camera settings].

86 I Using Various Functions

ﬂ CameraWindow - Canon k4 k4 4
rﬁcquire Images || Print %emote shoating

| o

Set My Camera

Confirms/changes camera settings

_‘_@l Uploads images to the camera

Dizplays this screen when the camera is connected




4 Enter the camcorder’s owner name and click [OK].

£ Camera Settings

Camera Model: Canon 4k % %
Firmware Yersion; 1.0.0.0

Owner's Mame:
Input a camcorder owner name ——— Canon |
here (up to 31 characters).

L QK __»J [ Cancel ] ’_ Apply

—

— et
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

70\ Users of Windows 2000 and Windows XP must first log in as an Administrator
\&¥] to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] »
[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser

EX Uninstall]
I .
1 Internet 7 My Documents
Inkernet Explorer
@™ E-mail | "q; My Pictures -

Outlook Express @ Set Program Access and Defaults
A5 Windows Catalog
“’ MSH Explarer & windows Update

® Windaws Media Play: I Accessories

5 fj Canan Ltilties

AR

'\‘{.‘E Windows Movie Mal ) Games
i) startup

@ Tour Windows XP

é Internet Explarer

— A Msh Explarer
dﬁ ZoomBrowser Ex s P

@ Outlock Express

I camerawindow ¥

I EOs Utiliey 3
) MovieEdt Task
7 Rawt Image Task

serEX b ﬁ ZoomBrowser EX

Eﬁ ZoomBrowser EX Readme

l': Remote Assistance % ZoomBrowser EX Uninstall

e ‘windows Media Player

LG b 3 ‘Wwindows Messenger
P| Log OFF @] Turn OFF ¢

o Other programs in the [Canon Utilities] folder can also be uninstalled in the
same way.

o Uninstall all programs in [Canon Utilities] when you have uninstalled
ZoomBrowser EX.

o RAW Image Task is used with Canon digital camera. The camcorder does
not support the program, but you can uninstall the program in the same way
as uninstalling the ZoomBrowser EX.

O
4
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Uninstalling the TWAIN Driver/WIA Driver

Connect the camcorder to the computer ([1] 25).

[E]

If a window for selecting an application program or the
Scanners and Cameras Wizard appears, click [Cancel]. If
ZoomBrowser EX started, close it.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation ([1]91).

Windows 98/Windows 2000:
1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.
2. Click [OK] to close the window.
3. Turn the camcorder POWER switch to OFF and remove the USB cable from
the computer.
4. Click the Windows [Start] menu and select [Programs], [Canon Utilities], [DV
TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”.
Windows Me:
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Ultilities], [DV
WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”".

When the Confirm Uninstall window appears, click [OK].
The uninstall process starts.

When the Maintenance Complete window appears, click
[Finish].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

= Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements: Built-in USB port on a system pre-installed with Windows 98,
Windows Me, Windows 2000, or Windows XP.

= There is no memory card in the camcorder.
Insert a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Turn the POWER switch to PLAY and move the TAPE/CARD switch to CARD.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([ 1] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

= TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the DIGITAL
VIDEO SOLUTION DISK (remove the check marks from the other programs
when prompted to select the programs to be installed).

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Turn the POWER switch to PLAY and move the TAPE/CARD switch to CARD.

Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

Cannot install the TWAIN Driver/WIA Driver correctly.

= Does the system have a built-in USB port and did it come with Windows
98/Windows Me/Windows 2000 preinstalled? (For Windows XP, no driver
is necessary to be installed.)

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([ 1] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.
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= Are you using the power adapter to power the camcorder?

= If the problem is not mentioned above, the TWAIN Driver/WIA Driver may
not have been recognized by Windows.
Uninstall and reinstall the driver. (For Windows XP, no driver is necessary to be
installed.)

TWAIN Driver/WIA Driver Uninstallation

If you have problems when uninstalling the driver, use the following procedures to
remove it.

[E]

’0\ The [Inf] folder contains numerous files that are critical to the computer’s
\&¥J operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Use the procedures below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the
[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before
installing the Digital Video Software.

Windows 98/Windows Me

Leave the camcorder connected to the computer.

O
4

1 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
The [System Properties] dialog appears.

Click the [Device Manager] tab.

W N

If [Canon Camera] appears under the [Other Devices] and/or
[Imaging Devices] categories, use the following procedures
to delete it.

1. Select [Canon Camera] and click [Remove].

2. In the confirmation dialog, click [OK].

3. Click [OK] to close the [System Properties] dialog.

5 Double-click the [My Computer] icon on the desktop
followed by the [C:] drive and the [Windows] and [Inf]
folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
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3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files
and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
In the [Inf] folder, double-click [Other] folder to open it.

Find and delete the [Canon.IncCAPxxx.inf] and
[Canon.IncCDVxxx.inf] file.
* The xxx represents numerals.
« If the above file is not contained in the [Other] folder, you do not need to delete
anything.

Windows 2000

Leave the camcorder connected to the computer.

AN DB ON -

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
Click the [Hardware] tab.
Click the [Device Manager] button.

If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedures to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click the
mouse button and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
Remove all copies of [Canon Camera] or your camcorder model name that
appear in the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.

Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. In the [Advanced setting] section, set the [Hidden files and folders] category
to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.
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4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

T Look for the file for Canon digital camcorders starting with
[Oem*]. El
* A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem*.inf] file. The two constitute one set.
» There may be many file sets starting with “Oem”.
* If you double-click an [Oem*.inf] file, the Windows Notepad program will start
and show the file contents. Click each [Oem*inf] file until you find one that
contains “*** Canon Camera Driver Setup File**” in its first line. When you
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.

Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct
files.

If You Were Using ZoomBrowser EX Version 2 or 3
(This manual explains version 5.x)

Titles and comments added using a prior version than ZoomBrowser EX
version 4 do not appear in ZoomBrowser EX 4 or higher.
= Titles and comments added using a prior version of ZoomBrowser EX will
not be displayed. Use the following procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in which you
installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].

3. Select the database you were using until now (C:\Program Files\Canon\
ZoomBrowser EX\Program) and click the [Start] button.

Please note that with ZoomBrowser EX 4 or higher, both titles and comments
appear in the comment list.

Cannot find the image folders saved with a prior version than ZoomBrowser
EX 5.x.
= Image folders saved under the [Program Files] folder (such as [Image

Library One]) cannot be displayed in the Main Window’s Folder Area of

ZoomBrowser EX 4 or higher. Use the following procedure to display

them.

1. In Windows Explorer, open the [Program Files] folder under the folder in
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\lmage Library One).

2. Select the image folder you wish to display and copy the folder to a different
destination.
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